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The principles of CCTV design in VideoCAD
Part III

3D modeling in VideoCAD

Edition for VideoCAD 7

S. Utochkin
In the first part of the article, we have considered modeling of a camera view area and the order of a simple project
creation. In the second part, we have considered how in VideoCAD a person detection area, person identification
area, license plate reading area and spatial resolution are automatically calculated for each camera in the project.
In the third part, we will consider means for 3D modeling of camera images.

Table of contents
Advantages of 3D modeling in CCTV design

2

Principles of three-dimensional modeling in VideoCAD

2

Practical example of three-dimensional modeling

4

Creation of three-dimensional model of environment on two-dimensional layout 5
Setting line types
Construction of 3D model of the office
Constructing walls
Constructing windows and door apertures
Constructing bookcases and desk
Constructing doors
Placing ready 3D models
3D images
Adjusting image quality according to equipment parameters
Adjusting camera parameters
Adjusting image processing parameters
Modeling an image according to equipment parameters
Modeling monitors
Setting the monitor model
Connecting cameras to the monitor
Additional features of the Monitor window

6
7
7
8
10
10
11
12
14
14
14
16
17
17
17
18

Adjusting the project on the basis of the image models

20

Modeling megapixel images

22

Shadows and Camera control area

23

Conclusion

© 2003-2011 CCTVCAD Software, http://www.cctvcad.com

25

2

Part III: 3D m odeling in VideoCAD

Advantages of 3D modeling in CCTV design
Three-dimensional models of video images are not a required part of CCTV project, two-dimensional layout can
contain all information necessary for CCTV system installation. Using VideoCAD tools, it is convenient to choose
positions and parameters of cameras, to work with view area projections, etc. on the two-dimensional layout.
However, the opportunity of three-dimensional modeling of images is extremely useful at design and project
negotiation stages.
Using three-dimensional modeling, it is possible to solve problems, arising during design, in the best way, taking
into account complex factors. For example, in two dimensions, it is difficult to take into account obstacles closing
a part of a view area and peculiarities of displaying three-dimensional objects.
Three-dimensional modeling allows to see even at design stage the output information of CCTV system - images
on monitors. This information will protect against expensive mistakes and will allow to choose arrangement and
parameters of equipment with high level of accuracy, and to find new unusual solutions for stated problems.
Modeling of images on monitors in real scale and quality can assist in choice of necessary quantity and
parameters of monitors, and also in designing an operator's workplace. In fact, not less than two kinds of images
from each camera are in the output information of CCTV system. Each kind of image has generally different
details. The image of the first kind is recorded in memory and can be used for the subsequent analysis. The image
of the second kind is watched by an operator during live monitoring. On a multiscreen monitor, this image can have
a small size and details. VideoCAD allows to model both recorded image from each camera, and multiscreen
monitors as a whole.
3D modeling can considerably simplify work during CCTV system design for a building, which is a project itself.
Modeling of images makes communication with a customer much more productive. Models of images are more
informative for non specialist, than only a camera placement layout with view area projections. Three-dimensional
models of images allow communicating with a customer in mutually understandable language, demonstrating
advantages of offered project at comparison of a competitor's project as well as avoiding disappointments because
of limited image resolution.
The substantiation of the project becomes simpler: from quantity and placement of cameras and monitors up to
qualitative parameters of equipment. It is obvious also, that the project with models of images on monitors has a
competitive advantage in tenders.

Principles of three-dimensional modeling in VideoCAD
3D modeling tools available in VideoCAD are intended for maximum precise CCTV system design with the
minimum efforts. VideoCAD performs routine work and offers creative part for a designer.
VideoCAD does not demand special knowledge of 3D modeling from a designer.
Actually, the designer should not work in 3D space, all constructions are carried out on usual plane. However, in
such a way the 3D model of environment can be created simply and quickly with sufficient details for CCTV
project.
There are no complex tools for modeling optical properties of materials, various three-dimensional visual effects,
etc. in VideoCAD. However, everything concerning cameras and modeling of their images in view of resolution,
sensitivity and typical distortions in CCTV systems is available.
Very often, it is necessary to see how a person, a car or other complex object will be displayed on screen. For this
purpose, VideoCAD contains library of ready 3D models. It is possible to enrich this library independently.
Because of the fact that 2D layouts are usually used in CCTV design, VideoCAD offers tools for fast transition from
2D layout to 3D model.
There are tools to model full-scale multi screen monitors with images from several cameras.
It is possible to model depth-of-field and limited visibility using known meteorological optical range, which can be
received from a weather report.
It is possible to model images from cameras in low light condition, taking into account camera and lens
parameters and also parameters of illumination and luminaries including discharge lamps and IR illuminators.
It is possible to simulate distortions of moving objects, depending on camera's parameters and creating animated
images.
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* Modeling depth-of-field, illumination, camera sensitivity and moving objects is beyond the scope of the article
and merit detailed consideration. You can find all necessary information including examples in the Help system.

As well as the previous parts of the article, this part acquaints only with the basic capabilities of the program. To
study deeper, it is necessary to address to the Help system.
* Tools are described according to the version VideoCAD 7.0.
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Practical example of three-dimensional modeling
Let's examine in a practical example, creation of separate camera images models and models of the images on
monitor during designing.
Let us suppose, we have two-dimensional layout of a building with 4 cameras placed preliminarily according to the
information from the first part of this article (Fig. 1). On the layout we see, what areas will be covered by each
camera. Separate lines mark projections of person detection and identification areas.
Using the tools described below we will be able to see images, which will be recorded by system, and the image
on the screen.
* Start of work with the VideoCAD software, work with back ground, placing and setting parameters of cameras is
described in details in the first part of the article.

Fig. 1. A site of an object with placed cameras. Camera 4 is selected.

There are walls, doors, a desk, bookcases, windows on the layout.
We know the vertical sizes of objects:
Height of walls – 3m;
Height of doorways - 2.2m;
Height of the desk – 0.75m;
Height of bookcases-2m;
Window apertures are from 0.7m up to 2m.
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Creation of three-dimensional model of environment on two-dimensional layout
For creation of three-dimensional constructions VideoCAD offers the following tools ( Fig. 2):
point

, horizontal line

inclined rectangle

, vertical line

, double line

, wall

, line segment

, polyline

, aperture in wall

, circle

, angle
, arc

, rectangle

,

.

In 3D space this constructions are stretched throughout the height and become 3D objects.
For example, a line turn into a vertical rectangle, a point – into a vertical segment, rectangle – into a parallelepiped,
circle – into a cylinder, etc.
To create 3D model it is necessary only to draw out the objects on the background (walls, doors,
windows, etc.) by constructions, setting values of the third coordinates (heights).
All actions are carried out on plane in the Graphics window.
The minimal and maximal heights, and also color of obtained 3D objects are initially set by parameters of line
type by which construction is drawn.
The heights can be set separately for each object, both during constructing, and editing by means of Current
construction parameter panel (Fig 2).
Color of constructions is defined only by line type, which is used at constructing.
* The Current construction parameter panel appears in the bottom of the Graphics window together with the
Line type panel in the moment of drawing or editing the constructions.
In other cases the Current construction parameter panel disappears.
* More about constructions see the Help system: Interface> Graphics window> Toolbar> Tools list>
"Constructions" button group.
In our simple example we will use only one tool - Rectangle

.

Fig. 2. The basic tools for three-dimensional modeling in the Graphics window.
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Setting line types
First of all, we will set parameters for separate line types for walls, desk and bookcases.
* The line type in this example will define the color and default values of the vertical sizes of 3D objects
constructed by this line type.
Choose Main menu>View> Options. In the appeared Options box choose Line tab.

Fig. 3. Setting line types

* In the right part of the Line tab we see System line types frame. These line types with numbers 14..30 are
used as system line types. For constructing it is necessary to use lines with any other numbers. For example, for
walls we use a line 40, for doors - line 41, for a desk - line 42, for book cases - line 43
Choose "40 " in the Number combo box and adjust this line type (Fig. 3).
Type the name of this line type - "Walls" in the Name box.
The Shadow box should be checked in order to constructions made by this line type, is considered as obstacle
in calculation of shading (see details below).
On the 3D panel, in Color combo box, choose color of three-dimensional walls - "Silver". In the Maximal height
box, type the height of walls known to us - 3.
For convenience of distinction of different line types on the layout, on Screen panel in the Color combo box
assign color for the line in the Graphics window - "Blue".
Leave without changes other parameters of the line type.
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* For detailed information about parameters of line types, see the Help system: Interface> Options> Lines
Similarly, adjust lines 41, 42, 43. Name them "Doors", "Desk s", "Book cases".
Assign:
For doors: the color of 3D objects - "Olive", the color in the Graphics window (Screen line color) - "Olive", the
maximal height - 2.2;
For the desk: the color of 3D objects - "Teal", the color in the Graphics window - "Teal", the minimal height 0.73, the maximal height 0.75 (thickness of the desk equal 2 cm);
For bookcases: the color of 3D objects "Maroon", the color in the Graphics window - "Maroon", the maximal
height - 2;
Click OK. The Option box will be closed.

Construction of 3D model of the office
Walls with windows and doorways can be constructed in two ways:
1. Using the Rectangle
tool only. Parts of walls under the openings between the openings and over the
openings are constructed separately.
2. With two tools: Wall
and Aperture in wall
. This way, first with the tool wall walls without openings are
constructed, and then using the Aperture in wall tool, openings in walls are made.
Here we consider the first way only - by using the Rectangle
Aperture in wall

tool. Descriptions of the tools Wall

and

you can find in the help system.

Constructing walls
Choose the Rectangle
tool (Fig. 2).
On the Line type panel, which appeared in the
bottom, in the Line type name combo box, choose
line type, adjusted at the previous step, by which we
are going to construct - "Walls".

On the Current construction parameter panel, in 3D H max box (Maximum height of 3D construction), height
of walls (3m), set by us, will be appeared. We have set this value as parameter of Line type. Zero value in 3D H
min box (Minimum height of 3D construction) means that walls will be on the ground.

Then simply draw out all walls and columns on the layout by rectangles. Don't draw out windows and doors. (Fig.
4).
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Fig. 4. Constructing walls

* After a construction has been drawn, in the right end of the Current construction parameter panel, the Edit
button appears. Click ing this button allows editing just created construction.
* For convenience it is possible to supervise constructing using images from cameras. For this purpose: Activate
any camera, by double click exact on its lens. Then display an image from this camera by click on the 3D
window
button (Fig. 2).
If on various sites of the layout we will activate cameras, which cover these sites, we can see in 3D window how
our work is being done (Fig. 5).

Fig. 5. Walls have been created. The view in 3D window from Camera 4 lifted on
15m. height.

Constructing windows and door apertures
A window is an aperture having two beams below and above. We will construct these beams separately.
The bottom beam is on the ground and has height of window-sills - 0.7m.
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For constructing the bottom beam choose Rectangle
. Then on the Line type panel appeared in the bottom,
in Line type name box, choose "Walls".
On the Current construction parameter panel, in 3D H max box (maximum height of 3D construction), type the
height of window-sills - 0.7.

Then construct rectangles in window apertures in the same way we constructed walls (Fig. 6).

Fig. 6. Constructing windows

Similarly, construct the top beams of windows as rectangles over the bottom beams. Before constructing in 3D H
min box (minimum height of 3D construction), it is necessary to type the height of window apertures (2). In the 3D
H max box (maximum height of 3D construction) correct value (3) is set in Line type parameters. It is not

necessary to change it

.

Similarly, construct the top beams above doorways as rectangles in doorways. Type 2.2 (height of doorways) in
the 3D H min box (minimal height of 3D constructions) before constructing.
* During creation of constructions it is possible to use rotating
scaling

and mirroring

, moving

, copying

, pasting

,

. For use of these tools, first of all, it is necessary to select construction, by

click ing on it in the selection mode

or by the selection window.

* For editing separate construction, double click on the construction. After that, pink grips will appear at its base
points. Further, it is possible to move the base points by mouse, to change line type and parameters of editing
construction on the appeared Current construction parameter panel. Using this panel it is possible to set
numerical values of the sizes in a similar manner as during constructing.
* For detailed information about selection and editing, see the Help system: Interface> Graphics window> Tool
bar>Tool list>"Constructions" buttons group>Select/Edit.
* For detailed information about Current construction parameter panel, see: Interface> Graphics window>
Pop-up panels> Current construction parameter panel.
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Fig. 7. Windows and doorways have been created. The view in 3D window from
Camera 4 lifted on 15m. height.

Constructing bookcases and desk
For constructing desk, choose Rectangle
again. On the Line type panel, in Line type name box, choose "
Desk s" line type .
After that, in 3D H min box (minimum height of 3D construction) height of the bottom of the desk (0.73) will
appear, in 3D H max box (maximum height of 3D construction) height of the top of the desk (0.75) will appear. The
heights we have set during adjustment Line type 42 ("Desk s").
Construct the desk, having drawn out the desk on the layout by rectangle. It is possible to construct legs of the
desk and others small elements, using the same line type, having set values for the minimum and maximum
heights on the Current construction parameter panel.
Similarly, construct bookcases, using "Book cases" line type.
* During constructing three-dimensional models for CCTV project it is not necessary to be k een on detailed
elaboration. In most cases only a form, sizes and position of an object have value.
Constructing doors
Doors are constructed similarly, using the line type "Doors", as rectangles. But we cannot construct a rotated
rectangle at once. Therefore, first it is necessary to construct a horizontal or vertical rectangle, and then to select
and turn it, 'having slightly opened a door' (Fig. 8). For rotating use the Rotate
tool.
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Fig. 8. Rotating door.

Placing ready 3D models
Place in necessary points three-dimensional models of persons.
For placing a model, click on the 3D model
button, then choose 3D model from the drop-down list. Then
every click on the layout will result to placing chosen 3D models (Fig. 9).
After placing, it is possible to select

and rotate

the 3D model in the necessary direction.

Fig. 9. Placing 3D models.

* It is possible to copy, move and rotate 3D models lik e other constructions.
On the Current construction parameter panel you can resize 3D models separately on axes.
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To do this, enter new values into X, Y, Z boxes during 3D model editing. If the
box is marked, change of any
size leads to proportional change of other sizes, thus model proportions are not broken. 3D model height above
the ground is displayed and can be changed in 3D H box.
* More about ready 3D models see the Help system: Interface> Graphics window>Menu bar>Menu items
list>Constructions>3D model
* It is possible to import in VideoCAD 3D models and scenes from the 3ds max software http://cctvcad.com/
Files/import_from_3dsmax.zip .
3D images
VideoCAD allows to place in the 3D space raster images in *.bmp and *.jpg formats.
In many cases the raster images can replace the 3D models which are difficult to make. They can be used for
modeling many objects from banknotes and plates up to a complex background.
To place 3D image click on the 3D image
button on the
Tool bar, then load raster image file, then specify minimum
and maximum heights on the Current construction
parameter panel, then place by clicking the 3D image on the
layout.
* More about 3D images see the Help system: Interface>
Graphics window>Menu bar>Menu items
list>Constructions>3D image

Fig. 10. The girl is a 3D image.
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Fig. 11. 3D model of the office has been created. The view in 3D window
from Camera 4 lifted on 15m. height.

So, three-dimensional model of the office has been created (Fig. 10), and it has not taken a lot of time.
By activating different cameras, we can see the images from them in the 3D window (Fig. 11). We can define
what objects get in view areas, what objects shade others. On the base of this information we can correct
positions and parameters of cameras.
* For sequential activating cameras it is convenient to use k eyboard shortcut Ctrl+Spacebar. Click on any place
of the Graphics window beforehand to set input focus to it.

Fig. 12. The image from Camera 3.
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Adjusting image quality according to equipment parameters
If we are interested, how detailed objects will look in the image, it is necessary for us to adjust parameters of the
image. In fact, the images obtained at the previous stage, do not take into account parameters of equipment,
therefore do not give information about how detailed this or that object will be recorded.
For example, a person's face, easily recognized on an image model, becomes a fuzzy spot on the real image (Fig.
14).
It is impossible to simulate image quality only by change of quantity of pixels, in CCTV there are specific
distortions (for example: compression, capturing by interlaced fields, loss of contrast) which cannot be reduced to
quantity of pixels only.
VideoCAD offers tools, which allow to simulate quality of camera image, which is very close to the real image.
For precise modeling, it is recommended to use exemplary images kept from the previous installations of a similar
set of equipment. Thus, all distortions of a path of videosignal are automatically taken into account. This technique
is described in detail in the Help system: Examples> Example 6 Determining person identification criteria
by a real image.
In the cases, which are not demanding special accuracy, it is enough to set parameters based on known
parameters of used equipment.
For example, we have identical color cameras with 1/3" image sensor, 752x582 effective pixels and an
inexpensive DVR, which can capture video only by interlaced fields with 640x240 pixels. Output image size is
640х480 pixels. The DVR and communication lines introduce some loss of resolution. For keeping information in a
certain period of time the middle compression is necessary.
Final horizontal resolution is 350 TV-lines.

Adjusting camera parameters
Activate the adjusting camera, open the Sensitivity and resolution box, by clicking on the Sensitivity and
resolution button
on the Tool bar.
On the Sensitivity and resolution box, to the
Number of pixels combo boxes enter the
number of effective pixels of the camera image
sensor.
Set Color and Resolution parameters.
Other parameters in the box are concerned with
camera sensitivity and illumination modeling.
Leave without changes the other parameters.
Close the Sensitivity and resolution box and
confirm changes.
* You can assign to cameras in the project camera models with set parameters. More about the camera models
see the Help system: Interface> Graphics window>Tool bar>Tools>View button group>Model of active
camera.

Adjusting image processing parameters
Open the 3D window
. Open the Image parameter panel by right-clicking on the 3D window. On the
Image parameter panel choose Processing tab.
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On the Processing tab, in the Image size panel, specify the number of
pixels of the output image.
Mark the One field box as video capturing is performed by interlaced fields.
Leave without changes the Brighness,Contrast and Sharpness sliders.
Move the Compression slider to position 3.
Click Save for saving the changed parameters.
If at clicking Save button the Save to selected cameras box was marked,
processing parameter set on the Processing tab would be saved in all
selected cameras.
After setting all processing parameters, mark the According to camera
parameters box.
If this box is checked, processing parameters are set according to
processing parameters of the active camera. As a result of activation of
other camera, processing parameters will be changed according to
processing parameters of this camera. Manual changing processing
parameters will be disabled.
If this box is not checked, processing parameters could be specified
manually. The set parameters will not be changed at activation of different
cameras.

During adjusting resolution, a yellow and green frames can appear on the image in the 3D window . These frames
are displayed as a result of the PiP function when the image size in the 3D window is less than the set number of
pixels in the image. PiP function will be described below in the Modeling megapixel images chapter. To
disable the PiP function, switch to the PiP tab and check the Off box.
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Modeling an image according to equipment parameters
Open the 3D window, by clicking the button
on the Toolbar of the Graphics window. In the Main menu of
the 3D window, check the item View> According to camera parameters.
If this item is checked, 3D window size and visibility of additional elements are set according to parameters of
active camera. As a result of activating other camera, 3D window size and visibility of additional elements will be
changed according to parameters of this camera. Manual changing will be disabled.
If this item is not checked, 3D window size and the visibility could be specified manually. The set parameters will
not be changed at activating different cameras.
It is possible to estimate the real resolution of the image model. For this purpose clear the item 3D window Main
menu>View> According to camera parameters, then check the item 3D window Main menu> View> Test
chart. The resolution can be determined by the point where the white and black diagonal lines are no longer
distinct (fade to grey).
After determining resolution check the item 3D window Main menu>View> According to camera parameters
again.
* If the image in the 3D window will be redrawn incorrect, for forced redrawing simply click on the image.
For saving or printing the image, choose in the Main menu>Image> Save as *.bmp (*.jpg, *.gif, *.tif, *.png) or
> Print.
By activating different cameras, you can obtain image models from them taking into account parameters of
equipment.

Fig. 13. At the left there is a fragment of image model in real scale taking into account real quality of recorded
images. At the right there is the fragment of image model without taking into account real quality.
* Pay attention, that it is not the entire image, but approximately a quarter of the image. Quality of the left
fragment corresponds to a recording quality of a middling DVR, which capture video by interlaced fields at an
middle compression, or an analog VTR with a multiplexer. The horizontal resolution is about 330 TV-lines.
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Modeling monitors
So, we have the modeled images from all cameras which our system will record. But, we are also interested in
what and how detailed the operator will see on the monitor during live monitoring.
For getting this information, VideoCAD offers tools for modeling images on monitors in real scale.

Setting the monitor model
Click on the Monitor window button

(Fig.2).

Fig. 14. Toolbar of the Monitor window.

In the appeared Monitor window, switch to the Edit mode, by clicking on the Edit button
Fig. 15). The button should look pressed.

on the Toolbar (

From the Monitor dimension combo box, choose "2x2" for simultaneous displaying images of the identical size
from four cameras.
From the Monitor diagonal combo box choose the diagonal of the physical monitor, for example 9 inches.
* If we leave "N/A" in the Monitor diagonal combo box, the size of the monitor will not be fixed, and we can
change it by mouse.
* An image on the monitor is modeled in real scale. Therefore, if we choose the diagonal of the monitor, which is
more than the diagonal of the real monitor, in front of which we work with the program, the monitor's model will be
shown not completely, and scroll bars will appear.

Connecting cameras to the monitor
As images from all our four cameras will be displayed on one monitor, select
window by selection window.

all cameras in the Graphic

* For connecting all cameras on the layout to the monitor, it is possible to select all on the layout using
k eyboard shortcut Ctrl+A. Click on any place of the Graphics window beforehand to set input focus to it.
Move cursor on the first (left top) cell of the Monitor window and click on it.

* The cursor will look lik e this

.

As a result of these actions, the 3D window will appear, in which images from all selected cameras will be
automatically modeled. Then the received models of images will be placed on the monitor in real scale, starting
from the cell you have just clicked (Fig. 16).
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Fig. 15. The Monitor window with connected cameras.

* The images in the Monitor window are modeled according to parameters of cameras and image processing,
irrespective of the current setting of the 3D window. Then the obtained models of images are scaled to size of the
monitor cells.
For obtaining images tak ing into account parameters of cameras and image processing, it is necessary to set the
parameters beforehand.
See above: Adjusting image quality according to equipment parameters.
After setting the monitor and connecting cameras, it is recommended to disable the Edit mode, by clicking on
the Edit button

once again. The button should look not pressed.

Additional features of the Monitor window
The Monitor window offers a lot of tools and flexible settings.
In one project, we can create up to 10 models of monitors, on each of which up to 100 images from cameras can
be displayed.
Each monitor can have the separate physical size, separate set of cameras and parameters.
On the monitor, you can delete, move, replace, copy, swap images.
You can adjust monitors so that different images have the different size.
You can limit the monitor resolution if an analog monitor is modeled.
You can set monitor aspect ratio and switch on/off stretching images with different aspect ratio.
You can switch day time in the project and model images from the same camera for daytime and nighttime.
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The Monitor window can display animated images and save them in the form of *.html file.
You can specify exact physical size and resolution of monitor.
Using pop-up menu invoked by a right click on the image, you can activate cameras, show 3D window with the
image from the camera, find cameras on the layout.
* More about the Monitor window, see the Help system: Interface> Monitor window.
So, we have obtained model of the image on the monitor watched by an operator during live monitoring (Fig. 16).
For saving or printing the image, choose in the Main menu of the Monitor window: Image> Save as *.bmp (*.
jpg, *.gif, *.tif, *.png) or > Print.
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Adjusting the project on the basis of the image models.
Having analyzed the image model on the monitor, we can find out necessity of changes of the project. It is simple
to make these changes:
1. Double-click on the image from camera, parameters of which should be changed. In result the 3D window
with the image from this camera will appear.
2. In the Main menu of the 3D window, check View>PTZH frame. In result, the field of view in the 3D window
will have been extended.
Real field of view will be limited by orange frame. On edges of the image, buttons will appear.
3. Using these buttons, it is possible to change camera positions and lens focal length similar to PTZ camera,
and height of installation in addition. The current values of the parameters will be displayed near the buttons (Fig.
17).
* These are the same parameters, which we can see in the Camera geometry box and about which we have read
in the first part of the article.

Fig. 16. PTZH frame in the 3D window.

4. Correct position of the camera, using these tools. At the same time, changes on the layout in the Graphics
window will be made automatically.
5. In the PTZH frame mode you can pan and tilt the camera by moving the image like moving drawing in the
Graphics window. Press left mouse button, move cursor with the button pressed then release the mouse button.
Camera tilt angle is changed through changing view area upper bound distance. But when Ctrl is pressed, the
tilt angle is changed through changing view area upper bound height.
You can also pan camera using the arrow keys.
6. For moving a camera on the layout, click by the right mouse button on the image in the Monitor window,
then choose Find on layouts in the pop up menu. This camera will be selected and shown on the layout in the
Graphics window. For moving, move the cursor precisely at the lens of the selected camera, then press the left
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mouse button, then move the cursor on a new place and release the left mouse button.
* You can also use the Move

tool.

7. After change of camera position, update the image from it on the monitor. For this purpose, right-click on the
image from the changed camera in the Monitor window and choose Update from the pop up menu.
8. If necessary, it is possible to create new cameras, by copying existing ones, then connect them to the
monitor. For connecting a new camera to the monitor, it is necessary to Select
then enable the Edit mode by clicking on the Edit button
camera should be displayed.

the camera on the layout,

, then click on the cell in which the image from this

9. If quantity of cells on the current monitor is not enough, it is possible to change quantity of simultaneously
displayed images on the current monitor in the Monitor dimension combo box or to use an additional monitor,
having chosen the new monitor in the Monitors list combo box (Fig. 15).
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Modeling megapixel images
Because of the Open GL limitation, we can not create three-dimensional image with a resolution in pixels more
than the screen resolution in Windows. However, modern megapixel cameras already have a much higher
resolution.
Even when the camera resolution is less than the screen resolution, it is inconvenient to work with images that
occupy a large area on the screen and require a lot of time for regeneration.
In most cases, we need only to see how an object on the scene will look on image from a camera with the
specified resolution.
VideoCAD solves this problem with the help of PiP technology (Picture in Picture).

Fig. 17. Picture in picture.

By default the PiP mode will be turned ON automatically when resolution of image in the 3D window exceeds size
of the 3D window in any dimension (in width or in height). In the 3D window a yellow rectangle will be displayed.
And in the corner of the 3D window, inside a green rectangle, a image fragment from the yellow rectangle will be
displayed.
You can quickly choose position of the yellow frame on the 3D view clicking by the middle mouse button (or
wheel). If there is no middle button, you can enable control by the left mouse button.
Thus, clicking on the 3D image by the middle mouse button, we can see how the parts of the image, which we are
interested in, will look in its original resolution.
The PiP mode offers flexible setting. You can specify which image will appear in the whole frame, but which in the
small picture, you can adjust the position and size of the small picture, you can additionally magnify the fragment
in the small picture.
To change PiP setting:
By right click on the 3D window open the Image parameter panel.
Chose PiP tab. Clear the According to camera parameters box if it is checked.
* More about the PiP mode, see the Help system: Interface> 3D window>Image parameter panel>PiP.
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Shadows and Camera control area
Before reading this chapter, let's revert to the first article in this cycle: The principle of CCTV design in VideoCAD
Part I. Camera view area.
In the definition of the view area in the first part it was mentioned that the object inside the view area will be visible
on screen only if it is not shadowed by other objects on the scene.
Let's introduce a new definition:
Camera control area - a complex dimensional figure inside the view area.
Camera control area forms by subtracting shadows of environment objects (uncontrolled areas) from the camera
view area.
Any object within the control area will be displayed on the screen.
VideoCAD can automatically calculate and display in the Graphics window (in 2D) horizontal projection of the
control areas, ie areas controlled by cameras taking into account shadowing from obstacles in environment.
To enable calculation of shading is necessary:
1. Model objects in a 3D environment as described in this article.
2. Turn on shadow calculation with the help of the Shadow
button on the Toolbar of the Graphics window (
see Figure 2). To enable shadow calculation of the active camera you should select Within projection
in
the drop-down menu of this button.
After a while VideoCAD will calculate the projection of the camera control area, taking into account shadowing
from obstacles in environment.

Fig. 18. Shadows.

The Shadow
button works in conjunction with the Spatial resolution
and the Fill projections
buttons. Depending on the state of these buttons, shadows can be displayed in different ways: as filling, as
shading, as a border lines, with mapping spatial resolution or not.
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Shadows - a new powerful yet easy-to-use tool of VideoCAD 7. Shadows are calculated for all positions of
cameras, shading objects can be located at any point of space. You should only enable calculation of shadows
with the help of this button.
Shading is calculated according to a simple rule:
A point on the horizontal projection is considered visible if a vertical segment, formed by this point in
the range of heights from the view area lower bound height to the view area upper bound height, is
visible wholly.
The calculation of shading - resource-intensive operation. During the shadow calculation on the Shadow
button red frame flashes .
The calculation of shading from 3D models is disabled by default to save resources. To enable the calculation of
shading from the 3D models, check the Options box> Miscellaneous> Shadow>Calculate shadows for 3D
models.
Additionally, for each 3D model, which must be taken into account when calculating the shading:
double click on the model to switch it to editing state;
on the appeared Current construction parameter panel check Shadow checkbox.
Whether or not a specific construction takes into account in the calculation of shading determines by the
Shadow checkbox of the line type used for the construction.
Drop-down menu of the Shadow

button:

Within projection - display view area projection taking into account shadows.
Dome - display projection of the territory controlled by the camera in 360 degrees, without view area
borders, but only taking into account the shadowing.
When the Dome item is chosen, actually the
control area of a dome (PTZ) camera is displayed.
The Dome mode is also useful for choosing the best
installation place for fixed cameras to make required
areas reachable for the cameras.
In the Dome mode all shaded areas from the
specified camera position become visible.

Off - disable shadow calculation and displaying.
A button state at the moment of camera saving determines whether the shadows of the camera will be displayed
when this camera is inactive.
If selected cameras exist on the layout, except the Active camera, this button changes view
operates the visibility of shadows of all selected cameras simultaneously.

(

and
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Conclusion
The use of three-dimensional modeling brings considerable advantages to CCTV system design.
VideoCAD offers the special tools intended for maximum exact CCTV system design with the minimum efforts.
Unlike other 3D editor software, VideoCAD provides means for modeling images taking into account real distortions
in CCTV, megapixel images, animated images, shadows from obstacles and multi-screen monitors.
Thanks to these means three-dimensional modeling can be used not only for a choice of lenses and places of
cameras, but also for a choice of qualitative parameters of all equipment, settings of system, and also in design of
operator's workplace.
In this article step by step on a practical example the basic tools of three-dimensional modeling in VideoCAD 7.0
from creation of 3D model of environment up to creation of image models on monitors are described.
In addition, the convenient method for final project adjustment, modeling megapixel images using PiP, taking into
account shading when calculating view area are described. Using the method described above, it is possible to
design CCTV systems, which really meet all requirements.
Back:
Part I. Camera view area.
Part II. Person detection area, person identification area, license plate reading area. Spatial resolution.
Continue:
Part IV. Illumination and camera sensitivity in CCTV.
Part V. Video surveillance of moving objects.
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